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Copyright © 2005, GE Security Inc. All rights reserved.

This document may not be copied in whole or in part, or otherwise reproduced except as
specifically permitted under US copyright law, without the prior written consent from GE.

Document number/revision: 0150-0143R.

The information in this document is subject to change without notice. GE, in keeping pace with
technological advances, is a company of product innovation. Therefore, it is difficult to ensure
that all information provided is entirely accurate and up-to-date. GE accepts no responsibility
for inaccuracies or omissions and specifically disclaims any liabilities, losses, or risks, personal
or otherwise, incurred as a consequence, directly or indirectly, of the use or application of any
of the contents of this document.

This publication may contain examples of screen captures and reports used in daily operations.
Examples may include fictitious names of individuals and companies. Any similarity to names
and addresses of actual businesses or persons is entirely coincidental.

GE and the GE monogram are registered trademarks of General Electric.
The WaveReader product and logo are registered trademarks of GE Security.

Other trade names used in this document may be trademarks or registered trademarks of the
manufacturers or vendors of the respective products.

GE software supplied with GE products is proprietary and furnished under license and can be
used or copied only in accordance with the license terms.

THE ENCLOSED PROGRAM IS FURNISHED SUBJECT TO THE TERMS AND CONDITIONS OF THIS
AGREEMENT. RETENTION OF THE PROGRAM FOR MORE THAN 30 DAYS, OPENING OF THE
SEALED WRAPPER, IF ANY, SURROUNDING THE PROGRAM, OR USE OF THE PROGRAM IN ANY
MANNER WILL BE CONSIDERED ACCEPTANCE OF THE AGREEMENT TERMS. IF THESE TERMS ARE
NOT ACCEPTABLE, RETURN THE UNUSED PROGRAM AND ANY ACCOMPANYING DOCUMENTATION
TO GE FOR A FULL REFUND OF THE LICENSE FEE PAID. (FOR INFORMATION REGARDING THE
RETURN OF PROGRAMS ENCODED OR INCORPORATED WITHIN EQUIPMENT, CONTACT THE
NEAREST GE SALES OFFICE.)

Use this product only for the purpose for which it was designed; refer to the data sheet and user
documentation. For the latest product information, contact your GE sales representative or visit
us online at www . gesecurity.com.

This equipment has been tested and found to comply with the limits for a Class A digital device,
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications.

You are cautioned that any changes or modifications not expressly approved by the party
responsible for compliance could void the user's authority to operate the equipment.

Direct all inquiries about GE's legal policies with regard to this product to:

Director of Legal Services

GE Security

12345 SW Leveton Drive
Tualatin, OR 97062-9938 USA
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Introduction
This is the GE WaveReader User Manual. This document includes an overview of the product and detailed
instructions explaining:

» how to view live and recorded video over a network and
* how to perform basic and advanced searches on recorded video.

There is also information describing how to contact technical support if you have questions or concerns.
To use this document effectively, you should have the following minimum qualifications:

» abasic knowledge of CCTV systems and components; and
» abasic knowledge of electrical wiring and low-voltage electrical connections.
Read these instructions and all ancillary documentation entirely before installing or operating this product.

The most current versions of this and related documentation may be found on our website. Refer to Online
publication library on page 64 for instructions on accessing our online publication library.

Note: A qualified service person, complying with all applicable codes, should perform all required hardware installation.

Conventions used in this document

The following conventions are used in this document:

Bold Menu items and buttons.

Italic Emphasis of an instruction or point; special terms.

File names, path names, windows, panes, tabs, fields, variables, and other GUI elements.

Titles of books and various documents.

Monospace Text that displays on the computer screen.

Programming or coding sequences.

Blue italic Hyperlinks to cross-references, related topics, and URL addresses.

Safety terms and symbols

These terms may appear in this manual:

& CAUTION Cautions identify conditions or practices that may result in damage to the equipment or other property.

A Warnings identify conditions or practices that could result in equipment damage or serious personal injury.
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Product Overview

Product Description

WaveReader provides you the ability to view video over Ethernet directly from:

» Digital video recorders (DVR and StoreSafe models).

» Digital video multiplexer recorders (DVMRe and DVMRe Triplex).
» Digital single channel recorders (DSR).

» Digital video storage (DVS) devices.

WaveReader also allows you to view or play video that has been archived onto a CD-R, DVD, or recorded
directly onto the hard drive of a PC.

Features

* Main window for viewing live or recorded video.

» Disk analysis window provides graphical overview of recorded data on a per camera basis.
* Remote access to DVMRe menu systems.

» Images can be captured, printed, and exported as a bitmap or JPEG file.

* Images can be enhanced using WaveStudio, as well as while viewing in real time.

» Basic and advanced searches launched from a single interactive search window.

» Advanced search filters that include alarm/event, text, camera, time, and date over multiple site
locations.

* Motion search by camera on DVMRe Triplex.

» Advanced retail text searches that include text strings and conditional text.

e Alarm Monitoring.

*  QuickWave evidence capture CD.

» Remote Pan/Tilt/Zoom camera control.

* Russian, French, and Polish languages selectable via Windows Control Panel.

e Multi-Site Mode, which allows users to view camera images from multiple DVMRe Triplexes
simultaneously on user definable screens.

»  WaveReader now supports live and recorded audio when connected to a DVMRe Triplex.



Minimum System Requirements
The following minimum system requirements must be met before software installation.

Table 1. Minimum system requirements

Hardware Specification

CPU Pentium Ill 1.2 GHz or faster
RAM 256MB

Hard disk drive 50 MB free hard drive space
Monitor SVGA, 1024 X 768, 24 bit color
Operating system Windows® 2000/XP

Windows® 2000/XP are registered trademarks of Microsoft Corporation
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Getting Started

Installation

Installing From CD-ROM
To install the WaveReader on your hard disk from a CD:

1. Place the WaveReader CD in the CD-ROM drive of a PC that meets the minimum system
requirements.

2. Follow the instructions for installation as they appear.

Note:  If Autorun is not enabled on your PC, choose Run from the Start Menu, then type d:\setup.exe (where
“d” is the drive letter of your CD-ROM) and click OK. Follow the instructions as they appear on your
screen.

Starting WaveReader

To start the WaveReader program, double-click on the WaveReader Desktop icon IE or choose Programs
from the Start menu and then select WaveReader. The Main window of the WaveReader program will
appear.

Figure 1. Initial WaveReader screen
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Logging In

To start using WaveReader you must Log In and connect to a remote device through the address book. When
logging in you will be asked for a User Name and Password. The default Administrator password is 12345.
The Setup menu becomes available after a successful login.

There are three ways to Log in and start using WaveReader:

1. From the Menu Bar click File, then Log In. The Login screen will appear.
2. Click the Login icon 44 on the Icon Bar. The Login screen will appear.

3. Click the Connect icon %l on the Icon Bar. The Login screen will appear. After a successful login
the address book will appear. This login method is the quickest way to connect to a device.

Figure 2. Login Screen

x

User Mame: I.-'i‘-.dministratur

Password: |****’1

ok LCancel

GE recommends that the user name and password be changed after the installation is complete by the system
administrator, see The Security Menus on page 22. As a security measure, store the password in the
administrator’s secure files or in a limited access area.

After a successful login, the Setup menu becomes available in the Main Menu The Setup menu contains the
following menu items:

* The address book

e Security settings

e Connection type setup
*  Network speed setup
*  DVMRe menu setup

If you logged in using method 3 from above the address book will automatically display. If you used methods 1
or two, move your mouse to the menu bar and click on Setup/Address Book.
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The Address Book is a comprehensive relational database consisting of the following fields:

»  Site Description

e Street Address

« City

» State/Province

» Zip/Postal Code
* Region/Country
* IP Address

» Ethernet (Connection type)

e Unit Type (VSR, SymNet, or IP Camera)

e Camera Quantity
e Serial Number
e Administrator of Unit

» Contact Phone Number

* Notes (4 fields)

The fields that are bolded above are the minimum amount of information that WaveReader requires to connect

to a remote device.

Figure 3. The Address Book
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Connecting to a Site/Device via the Address Book

Highlight a selection on the Address Book and double-click or click on the Select button. WaveReader will
attempt to add the device/site to the site tree and start showing video using the parameters specified in the
database (see Figure 3). See Site Administration on page 25 for information on creating and editing entries in
the Address Book. If WaveReader cannot connect to the device/site it will display a time-out message. Verify
that the parameters in the Address Book are correct. If the parameters are correct verify that the PC can connect
to the Internet or to another ethernet connected device.



Figure 4. WaveReader Screen after a successful login
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The figure above shows a connection to a StoreSafe Pro Il with 6 cameras connected.
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WaveReader Reference

WaveReader Main Window Overview

Figure 5. Main window overview
Multi-Site Menu

SEart 0

Stop

View Menu

Disk Analysis Screen

L) Setup Menu AulfDelete She Group
address ok u Growp S0

0 Securty »| Search Menu =nm»
File Menu Connection Type Setup » ,?Aelec'i"?, :his ) v Audsrivist shor's e Grous (1) Alarm-Monitor Menu
O, Network Speed » lenu will launct Salect Soresn
e e (SetunDRe e > 15 e e e Start the Alarm Monikor
Prind Image Stop the Alarm Monitar
Sart WineoStudes
et ki 0 W Record Menu Help Menu
Log OFF Record Setip P

Help Topics

Bk Sark Rscording

About MUK
prf— -

About:

=101
Menu Bar — s v et Recod sesch
Icon Bar — —_
| H|»
AL [ 1
-4 >
Button 1 Disconnect
Panel 1z2)z3|4
5 3 7 8
101112
13| 14| 15| 16
Main_
ojo)= — Viewing
| @ Area
C(B| .
> @ T
ar|-
set [ Golo
Freset 1 =l
Text Data
Display Box —
Status Bar——!Comscledio GB'sunt N

Right-Click on any

EICECT I Single Camera Display

«[u]» for Image Control
Click on any < w l" Pop-Up Menu
Image to change >
to Single Camera Disteses
Display |2 =
S|&e|7]|e8
9 wl |z
LERIRCHIRLY I
Oojo|fao
A =]
E=- T ;
P vz
RE
se | GaTa
Precet 1 =l

Conmeciedio: G8's ik ]



The Main Program Window

The Main program window consists of the following areas:

* The Menu Bar: At the top of the window.

e The Icon Bar: Underneath the Menu Bar.

* The Main Viewing Area: The large main area.

» The Status Bar: At the bottom of the window.

*  The Button Panel: The left side of the window.

* The Text Data Display Box: Located under the Main Viewing Area.
* Image Control Pop-Up Menu: Right-click on a Single Display.

The Menu Bar

The Menu Bar provides access to the programs functions and parameters, as well as access to files. The Menu
Bar changes its appearance to reflect the program mode it is operating in.

Figure 6. The menu bar
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The Icon Bar

The Icon Bar provides one-click access to program functions and parameters, as well as access to files.

Figure 7. The Icon Bar
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1. Login: Use to log in to a unit.

2. Connect/Disconnect: Click to connect and launch the address book or disconnect.
3. Open files: Opens mpc and mpg files for playback.

4, Save: Save files

5. Print: Prints images displayed in the main viewing area.
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6. Live mode: Selects live look-in mode.
7. Playback mode: Selects playback mode.
8. Audio On/Mute: Toggle audio on or off.
9. Record button: Toggles recording on or off.
10. Search menu: Launches the search dialog window.
11. WaveStudio: Launches WaveStudio.
12. Snapshot: Click to capture images.

The Main Viewing Area

Video is displayed in this area. Video display order is according to the information encoded by the unit used to
create the original video data file. Currently selected video is indicated by a light blue bounding box.

The Status Bar

The Status Bar displays messages and current connection status information such as the IP address and
recording speed in pictures per second (pps). If the user is viewing data recorded as files on a CD-ROM or
stored on the user’s PC, the path name information is displayed on the status bar.

The Button Panel

The button panel contains various controls for camera selection, viewing and playback. The lower portion of
the button panel controls the various features available with PTZ (pan. tilt, and zoom) cameras. Please see your
dome or PTZ camera installation manual for setup information.



Figure 8.
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Play Backward button: Click on this button to playback video in reverse.

Stop button: Click on this button to halt all playback operations. The Play Pointer Slider Bar moves to
the start of data.

Play Forward button: Click on this button to playback video.
Single Frame Rewind button: Click on this button to rewind the video a single frame.

Pause button: Pauses playback until the Pause button is pressed again. Clicking any of the buttons,
except Stop will also resume playback. The Play Pointer slider bar stays at the current position while
paused.

Single Frame Advance button: Click on this button to advance the video a single frame.
Rewind button: Click on this button to perform high-speed reverse playback.
Fast Forward button: Click on this button to perform high-speed playback.

Connect/Disconnect button: Click on this button to display the address book (after a successful
login).

. Number buttons: Press any of these buttons to call up individual cameras for display. When

connected to a unit that has more than 16 cameras, right-clicking over the number buttons will display
numbers 17 through 32. Right-click again to return to cameras 1 through 16.

Single Camera Display Size: Choose from Small, Medium, or Large.

11
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12.
13.

14.
15.
16.

17.

18.
19.

20.

21.

Multiscreen button: Choose from a Large 4-way, Medium 16-way, or Large 16-way.

Iris Open and Close: Click and hold the Iris Open or Close buttons to lighten or darken the image,
and adjust for changing light conditions.

Focus In and Out: Click and hold the Focus In or Out buttons to operate lens focus.
Zoom In and Out: Click and hold the Zoom In or Out buttons to operate the camera lens zoom.

Auto Zoom In: Click the Auto Zoom In button, then click and draw a rectangular window on the
currently displayed image with the left mouse button. Once the button is released, the camera will
automatically zooms to the drawn window. If the window size is beyond the camera’s zoom
capabilities, the image will center on the middle of the defined window at the maximum zoom-in
position.

Return — Previous button: Click on this button to return the camera to the PTZ position that was
selected prior to the last Auto Zoom In command.

Zoom All: Click on this button to zoom all the way out on the currently selected camera.

Set Preset: Navigate the camera to the desired location, select the desired preset from the drop down
list box, then click Set.

Go To: To send the camera to the desired preset, select the preset from the drop down list box, then
click Go To.

Preset: Drop down list of preset camera positions created with the Set Preset button.

Activated Button Indicator

When the Play Forward, Play Reverse, Fast Forward, and Rewind buttons are clicked, the icon color changes
from black to green. When the Pause button is clicked, the icon color changes from black to red.

The Text Data Display Box

The Text Data Display Box shows any encoded text associated with the current video image.

The Image Control Pop-up Menu

Right-click on any single camera display and the Image Control Pop-up menu appears. Select any command to
perform the selected action on the current image. Once the image enhancements are applied, doing a "restore"
will not display the original image. This "restore™ will be applied to future images from that camera. The
enhancements only affect the way the image is viewed and do not affect the actual image itself.



Figure 9. The image control pop-up menu
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The following video enhancements are available on this menu:

» Image Selection by Camera Number (when multiscreens are displayed)
e Zoom In and Zoom Out.

* Contrast

* Intensity

» Enhance

» Sharpen

 Blur

* Restore (Current Camera)
* Restore All

» Image Quality from 1 (low) to 5 (high) and B/W.

Note:  The image quality settings are not available on the StoreSafe Pro II.

Changing Languages

WaveReader can be setup in one of four languages, English, French, Russian, or Polish. English is the default
language. To change the language open the Windows Control Panel and select Regional Options/Locale,
then select the language.
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WaveReader Operation

This section details the operation of WaveReader through the commands located in the menu system.

The File Menu

Open File

From the Menu Bar, click File, then click Open or click the Open icon on the Icon Bar. The Open files dialog
box will appear (depending on the operating system, some windows may differ from the one shown here).

Figure 10. The open file dialog box

305
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e File name: = Open
My Network P...
Files of type: Wavelet Image Recordings (*RDB) j Cancel I
Wavelet Image Sequences (*60D) v/
Modified Wavelets (*20D

Wavelet Image Recordings ("RDE)
1. Select the drive and the directory that contains the video files that you want to open.
2. Select the file type from the drop down menu.

Note:  WaveReader can open the following filetypes:

e 60dis a wavelet video clip in a proprietary data format. The file sizes are in multiples of 2Mb.

e rdb savesimages in a database and is typically used for shorter video clips. This type of file loops back and
continues to play after reaching the end of the video.

e 20d is similar to the 60d except this format is used for the StoreSafe Pro II.
3. Select the file for display and click on the Open button.

4. The file will load, but will not start playing until the play forward button is depressed. The play
forward button turns green to indicate when play operations have started.



Figure 11. WaveReader playing a file
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The screen shown above is the medium format 16-way multiscreen camera view. Clicking any camera image
will display that camera image in full screen.

Conditional Indicators
The following conditional indicators can be displayed during playback:

» Arred letter A opposite the camera number means an alarm occurred on that camera.
» Avyellow letter E opposite the camera number means an event occurred on that camera.
» A green letter M opposite the camera number means that motion has been detected on that camera.

Save Image

From the Menu Bar, click File, and then click Save File or click the Save File icon on the Icon Bar. The Save
Current Image to A File window will appear. The currently displayed video image may be saved with the
user specifying the file name to be used, and the file type (*.bmp or *.jpg) to be chosen. (The asterisk stands
for the file name.)

The benefit to this method as opposed to using the Snapshot icon is that the images can be saved with a more
appropriate file name that better describes the picture’s content rather than letting the software automatically
assign a numerically sequenced file name.

The disadvantage to using this method is that playback operations continue while the user is interacting with
the dialog box and specifying the file name. If the user misses seeing portions of the video, it will be necessary
to replay those sections again so that they may be viewed without further distractions.

15
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Print Image

From the Menu Bar click File, then Print Image or click the Print Image icon on the Icon Bar. The Print
Image menu allows the user to print whatever is displayed in the Main Viewing area using you default
windows printer.

Start WaveStudio

WaveStudio is an image enhancement program designed specifically for use with WaveReader. WaveStudio
allows the user to capture and save images. WaveStudio also allows the user to increase or decrease contrast,
zoom, sharpen lines, enhance sections of the picture, and bring out detail in dark areas. For information on how
to use WaveStudio, please see Using WaveStudio on page 54.

Start QuickWave CD Wizard

When WaveReader is running on a PC that has DirectCD® Version 3.0 or higher installed, the Wizard can be
used to automate the process of creating a QuickWave CD.

1. Select File, then Start QuickWave CD Wizard from the menu to launch the Wizard. (If this menu
item does not appear in the menus, then the CD writing software could not be detected on the PC and
the Wizard cannot be used.

2. The Wizard will guide you through the CD creation process.

Log In/Off

From the Menu Bar click File, then Log In or click the Log In icon on the Icon Bar. The Login screen will
appear. The default Administrator password is 12345. It is recommended that this password be changed after
installation is complete. As a security measure, store the password in the administrator’s secure files or in a
limited access area. After a successful login, the log in commands changes to log off and the Setup menu
becomes available in the Main Menu bar.

Exit

From the Menu Bar click on File, then Exit. This command terminates the WaveReader program and closes all
associated windows.

The View Menu

The View menu appears between File and Setup menus. The following commands are available in the View
menu:

» Disk Analysis Screen: This command displays the Disk Analysis screen.
» Text Log: This feature allows the user to view any text associated with the video.



The Disk Analysis Screen

Figure 12. The disk analysis screen

The Volume drop down list box provides for selection of alternate hard disks if available.

The blue area below the legend displays the time/date of the disk area pointed to by the mouse cursor. When
selecting a block of data this area will display the start and end time and date of the selected block.
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Horizontal color bars indicate the following:

* Green: Standard Video

 Black: Camera Disabled or Absent

* Red: Alarm Mode
e Blue: Video Loss

*  White: End of Disk
e Yellow: Events

» Orange: Activity

Vertical Color cursors indicate the following:

» Light Blue: Play indicator, positioned by progress slider bar.

» Pink: Record Marker indicates the current recording position on a multi-volume unit.
» Red: Leftand right markers to assist with defining boundaries for data retrieval, etc. Click and Drag

to the right to place the red cursors in the desired position.

Zoom In and Out using the Magnifying Glass, or follow the prompts after clicking on the data bars.

17



18

WaveReader
User Manual

Clicking the left mouse button in the Disk Analysis screen displays a Pop-Up menu with the following
commands:

* Play

» Save File (with selected file size)

» Search (Opens the Event Search Filters Screen)
e Zoom In

* Cancel

Figure 13. Disk analysis pop-up

Play
Save file [2176MB]
Search

Zoom In

Cancel

To retrieve previously recorded video, click and drag (with the left mouse button) over the data bars. Use the
magnifying glass to get a more detailed selection. The Pop-Up menu will display the estimated file size of the
selected video.

Once a selection has been made the above commands may be executed.

The Volume drop down list box

When looking for video from a particular date on the drop down list box, please note that the oldest data is
continually being recorded over with the newest video. One of the listed disk volumes will contain both the
oldest and newest video data.

Figure 14. The volume drop-down list

No 1: <5/24/2002 3:01:42 PM - 5/30/2002 5:37:54 PM>
No 2: <56/30/2002 5:37:54 PM - 6/3/2002 8:27:48 PM>
No 3: <6/3/2002 8:27:48 PM - 6/7/2002 3:41:18 AM>
Mo 4: <6/7/2002 9:41:18 AM - 6/10/2002

: <B/13/2002 1:58:58 PM - 6/12/2002
No B: <5/14/2002 3:08:16 PM - 5/17/2002 2:18:17 AM>
No 7: <6/17/2002 2:18:18 AM - 5/19/2002 3:38:58 PM>

Mo 8: <5/19/2002 3:38:58 PM - 5/27/2002 2:21:24 AM>

For example: If searching for video on 5/15/2002, you should select volume No.6, not volume No.5.

Saving A File From The Disk Analysis Window
This feature is only available during an ethernet connection.

1. Click and drag the mouse to select the desired data you wish to save. Use the Zoom In and Out
function to select smaller blocks of data to save.

2. Click and drag the vertical red bars to alter the size of the selected information.



3. Click Save File in the pop-up menu. The Save an Image Sequence window will appear.

4. Select the desired file name and location, then click Save.

The Text Log

WaveReader allows the user to view any text associated with video while connected to a unit or playing back
video from a .60d file. Select View / Text Log from the Menu bar. The Text Log will appear.

Figure 15. The text log

loix
| File
Save all the Lines to a File -]
Print Selected Lines with Current Image Save the Selacted Lines to & File §48.41
o g 505 Staffing Services, Inc. §86.61
32 SYNAVANT Inc. §139.32
32 TENERA, Inc. §115.46
<6,/9/2003 8:32: [DNBE] The Dun & Bradscreet Corporation §74.54
<6/9/2003 B:32:05 [TECI] The Keith Companies, Inc. $145.25
<6/9/2003 8:32:05 j
¥ Show Timestamp [~ Freeze Log
Clear | ¥ Show Camera Number 4’0«:

Other options include the ability to Print or Save the Text Log. The Text information is save as a .txt file in the
QuickWave CD folder by default.

The Setup Menu

The Setup menu is not enabled when the program first starts. It is enabled only after a successful login.

Figure 16. The setup menu

| Change Password
View User Rights
Site Administr ation
Group Administration
User Administration

Unit Type Setup
Custom Caption Setup

v Normal Connection
Live Connection

Setup Menu

Address Book

Security 7 v Fast (LAN)

Connection Type Setup » Slow (Modem)

Network Speed 3

Setup DVMRe Menu 3
Display DYMRe Menu
Load Default Data
Get from DVYMRe
Send to DYMRe
Load Data from a file
Save Data to a file
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The following menus are disabled after a connection is established between WaveReader and a Device:

e The Address Book
e Connection Type Setup

e Security

The Address Book

The Address Book is a comprehensive relational database consisting of the following fields:

e Site Description

e Street Address
* City
e  State/Province

e Zip/Postal Code
* Region/Country
* IP Address/Phone Number
» Ethernet/POTS (Connection type)
e Unit Type (DSR, DVMRe, etc.)
»  Camera Quantity

*  Serial Number

e Administrator of Unit

e Contact Phone

Number

* Notes (4 fields)

Figure 17. The address book
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The lower portion of the Address Book contains groups of command buttons. See the illustration above.

Use the Column/ Search fields to perform searches by category and keyword.



Use the Export button to send the Address Book data into one of or all the following filetypes:

* A Delimited File

* AnHTML File

* An Excel File
Use the Print button to send the Address Book data to the default printer in a spreadsheet-like format.
Connecting to a Site/Device via the Address Book

Highlight a selection on the Address Book and double-click, or click on the Connect button. WaveReader will
attempt to connect to the device/site using the parameters specified in the database. See Site Administration on
page 25 for information on creating and editing the Address Book. If WaveReader cannot connect to the
device/site it will display a time-out message. Verify that the parameters in the Address Book are correct. If the
parameters are correct verify that the PC can connect to the Internet or to another ethernet connected device.

Editing the Address Book
To edit the Address Book, click on the Edit button. The Site edit window will appear.

Figure 18. Editing the address book

[aises x|
Description: [Hiew':DSRET
Ethemet/POTS: [Ethemet

IP/Phone Number:  [1050 25361
Urst Password
Serial Humber:
Uit Type: DSR ﬂ
Camera OTY: [
Administraton of Unit [
Contact Phone Number: |
Street |
Cay. |
State/Frovince |
Zip/Postal Code: |
I
[
I
[
I

Region/Country:

Holes 1:
Notes 2
Noles 3
MNotes 4

Add Edit ] Delete ! Search I Close |
W] 4 Fecod 1 » o]

| I—~ Previous Record Next Reccrd—l |
1" Record Last Record

This window allows the user to:

* Add new device/site information. Clicking on ADD also provides the option of importing an Address
Book that has been saved as a .lst file from a previous version of WaveReader

» Edit existing records.
» Delete existing records.

» Search through current records by the Site Description, IP/Phone Number, Street, City, State/Province,
Zip/Postal Code, or Region/Country fields.

Note: A Unit Password is not required if the unit’s password is left in it's default (1111). If the Ethernet password is changed on
the unit, the unit password in the Sites window must be entered and must match exaclty.
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The Security Menus

Security Shell Overview

The Security Shell is designed to provide controlled access to multiple Digital Recorder units by multiple
users. The following definitions are used in the discussion below:

e User: A person that uses the WaveReader to review data stored on a Digital Video Recorder (DVR).
* Group: A collection of Users that have specific access rights to a specific list of Sites.
» Site: A specific Digital recorder with a unique IP address.

Users are assigned to specific Groups. Any number of Groups can be defined. Every user can only belong to
one Group. The default Group is called the Administrator group and cannot be deleted from the database.
Users that are assigned to the Administrator Group have full access rights to all Sites in the Database. The
Administrator is the default user in the Administrator group. Examples of Groups names would be:
Management, Engineering, Supervisor and Shipping.

Only Users who belong to the Administrator Group have access to all administrative functions — all other users
are only allowed to change their own passwords and to view their user rights.

All groups except the Administrator group have specific sites that are associated with them. Every Site in the

database can be associated with any number of Groups. A Group also has access rights that can be set up that

apply to all Sites in the Group. A Supervisor Group for example might have the right to do Pan, Tilt and Zoom
on all Sites associated with the group.

A Group may also be set up to have unique access rights on a per Site basis. The administrator can specify for
each site belonging to the group, which cameras can be viewed by the group’s users. For example, the users
that belong to group ‘A’ can only view cameras 1 to 8 from a specific site whereas users belonging to Group
‘B’ are only allowed to view cameras 9 — 16 from the same site.

Using the Security database from multiple computers.

When WaveReader has been installed on several networked computers, it is possible to use only one central
database that can easily be maintained by the Administrator.

During the installation of WaveReader on a clean Computer, the Security Database is copied to the
WaveReader folder. The filename is WRSecurity.mdb. This file can be moved to a drive on the network that
can be accessed from the PC. The WaveReader then has to be instructed where the database is located. This is
done as follows:
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Using any ASCII editor like Notepad, open the file BWVAL.DAT that is located in the WaveReader folder.
Edit or add the following line to reflect the new position of the database on the network: (The part following
the ‘= is the network path of the WRSecurity.mdb file).

SECURITY_DB_PATH_AND_FILENAME = P:\Security\WRSecurity.mdb

Be sure to remove the letters “REM” that may come before the string. The next time WaveReader is launched
it will get its Security settings from the network database. Several Computers can be set up this way to
simultaneously access the same database file.

If the WRSecurity.mdb file is not moved to the network, each WaveReader will simply access the database on
its local hard drive and the site and user information will have to be added to every database individually.

Additional Notes

It is recommended that the Administrator always add at least 1 user beside himself to the Administrator group.
If he forgets his password, the other user can still log in and reset the Administrator’s password. If all users in
the Administrator group forget their passwords, they would have to contact GE Technical Support to have their
passwords reset.

Uninstalling WaveReader from a PC will not remove the BWVAL.DAT file or the WRSecurity.mdb database
file from the WaveReader folder. When the new WaveReader is installed, a user will be able to log into the old
database without any additional setup.

Security Menu Sub Menus

WaveReader features extensive security and administrative options. From the Menu Bar click Setup, then
Security.

Figure 19. The security sub-menus

File View | Setup Alarm-Monitor Help
[ (o Adress ook bl al;l clml
— Security Change Password
< | | Connection Type Setup »  View User Rights
e Site Administration
Speed >
Il | Network Group Administration
Setup DVR Menu s
I—T waﬂdnr@atbn
Unit Type Setup
Connect Custom Caption Setup
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The following sub-menus are available:

» Change Password

*  View User Rights

» Site Administration

e Group Administration
*  User Administration

* Unit Type Setup

e Custom Caption Setup

Change Password

It is recommended that the default password be changed after installation is complete. By default, the
password is 12345 when the software is first installed. As a security measure, store the password in the
administrators secure files or in a limited access area.

Figure 20. The change password window

x|

New Password: I

Confirm Password: |

OK Cancel |

To change the Password, select Setup / Security / Change Password from the menu bar. The Change
Password window will appear.

Click in the box labeled New Password.
Type in the new password.
Click in the box labeled Confirm Password.

Type in the new password again.

o &~ e

To complete the selection, click the OK button. If the new password was accepted the Password
Accepted box will be displayed.

6. If the Cancel button is chosen, the password will not be changed.

View User Rights

To View User Rights, select Setup / Security / View User Rights from the menu bar. The Group’s Rights
window will be displayed. This window provides a quick overview of User and Group rights that have been
setup in the Group Administration database. No editing functions may be performed in this window.
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Figure 21. The groups rights window
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Site Administration

Site Administration provides all the data required for the creation of the Address Book. To access Site
Administration, select Setup / Security / Site Administration from the menu bar. The Sites Edit window will

be displayed.

Figure 22. The sites administration window

Creating the Site Address Book

This window allows the user to:

s x|

Description:
Ethemet/POTS:
IP/Phone Number:
Urdt Password:

Serial Humber:

Uit Type:

Camera QTY:
Administrator of Unit:
Contact Phone Number:
Street
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10.90.253 61

DSR
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W[ 4 [Recad » o]

| I— Previous Record

1" Record

Next Reccrd—l |
Last Record

* Add new device/site information. Required fields are Bolded. Clicking on ADD also provides the
option of importing an Address Book that has been saved as a .Ist file from a previous version of

WaveReader
» Edit existing records.
» Delete existing records.

» Search through current records by the Site Description, IP/Phone Number, Street, City, State/Province,
Zip/Postal Code, or Region/Country fields.
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Importing an Address Book (from versions of WaveReader earlier than 2.5)

Figure 23. Importing an address book

Click on the ADD button in the Sites window. This modifies the button bar on the bottom of the window to
include an Import Sites button. Follow the steps below to import the Address Book.

1. Click on the Import Sites Button. This brings up the Import Sites windows.
2. Click Import Sites from Address Book File. This brings up the Open List File window.
3. Navigate to the folder in which the .Ist file resides.

Note:  NOTE: A Ist file may be created using any text editor such as Notepad. See the section titled Creating an
Address File on the following pages.

4. Select the .Ist file and click Open. This places the address list in the Import Sites window.
5. Click Add all Selected Sites to the Database.
Creating an Address File (for basic information)

The Address Book file may be created using any text edit such as Notepad. A sample address book may look
like the following. Be sure to save or rename the file with the extension, .Ist. Once created the user can import
the file using the previous procedure.

Figure 24. The address file
1000
3
0,"10.90.253.129""Alex's unit","12345"
0,"10.90.10.110","demo room","54321"
0,"10.90.253.28","Test unit",""

The first line (1000): Indicates a version number used by WaveReader to identify this list. Do not edit this
number.
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The second line (3): Indicates the number of addresses in the list. Change this number only if the number of
address in the list changes.

The address line indicates the following 4 items:
e This unit is connected via ethernet (indicated with a 0), or this unit is connected via a modem

(indicated with a 1).

» The IP address or telephone number of the remote unit (example IP address show above
"10.90.253.129")

» The name given to the remote unit (Example: “Alex’s unit”)

» The password for connecting to the remote unit (Example: “12345”). This field is not always
populated.

Group Administration

Group Administration provides all the parameters required to set up various Group rights and access levels. To
access Group Administration, select Setup / Security / Group Administration from the menu bar. The
Groups Edit window will be displayed.

Figure 25. The groups window
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Connection Type Seting: Mol & Live

Change Image Qually. [ Record Whie Viewing [~
Advanced Search V Save Clip From Unit =
View WaveStudio: P PTZ Functionality: F
View User-Rights: 4 Menu Setup: P
Multi-Site: W Alam-Monitor F

:

4] | i
add | Edt | Deete | Seach |  Ciose |
[ 4 [Recod 3 » 0

This window allows the user to:

* Add new Groups, set their Access Level and Connection Type. Set their Group Rights and the Sites
they have access to.

» Editexisting records. Clicking in the Edit button adds a Show Users and Add All Sites Button on the
Button Bar. The Show Users button displays all users in the currently selected group. The Add All
Sites button will add all available Sites to the selected group.

» Delete existing records.
» Search through current records by Group Name, Access Level and Connection Type fields.
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Access Levels

The Access Levels are priority ratings used by the unit to determine if a currently established connection
should terminate when a user with a higher priority level requests a connection.

If the current user has a lower access level, the unit will break its connection after sending a message to the
users PC indicating that their connection has been terminated.

The status bar at the bottom of the WaveReader main window will also indicate that the unit terminated the
connection.

There are three levels of access that can be set up in WaveReader:

e 1 (lowest)
e 2
e 3 (highest)

User Administration

User Administration provides all the data required for adding Users and user information into various Groups.
The users will have the rights and access levels of the group to which they are assigned.

To access User Administration, select Setup / Security / User Administration from the menu bar. The Users
Edit window will be displayed.

Figure 26. The user window
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Password: [
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This window allows the user to:

e Add new users.

» Edit existing users.

* Delete existing users.

e Search through current records by User Name, Phone Number, Email Address, and Group Name.

Unit Type Setup

Unit Type Setup provides the data required for Unit Type field in the Site Administration window. To access
Unit Type Setup, select Setup / Security / Unit Type Setup from the menu bar. The Unit Type Edit window
will be displayed.



Figure 27. The unit type window
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This window allows the user to:

* Add new devices.
» Edit existing devices.
» Delete existing devices.

Custom Caption Setup

The Custom Caption Setup menu allows the user to change the 4 provided Notes fields into user labelled fields.
To access the Custom Caption Setup, select Setup / Security / Custom Caption Setup from the menu bar. The
Custom Caption Setup Edit window will be displayed.

Figure 28. The custom caption setup window

x
Field Name Caption
Notes 1: |Noles 1
Notes 2: |Notes 2
Notes 3: {Notes 3
Notes 4: {Notes 4
Update | Cancel |

To relabel a field name simply highlight the current label, type in the new designation and click on the Update
button.

Connection Type Setup

Two types of Ethernet connections can be established between the WaveReader software and a unit.

* Normal Connection
e Live Connection
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Figure 29. The connection type setup sub-menus
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Normal Connections

When a Normal Connection is made, the user may select between two operating modes:

View Playback Mode: Allows the user to view and search recorded data from the units hard disk.
View Live Mode: Allows the user to view live images. View Live Mode is the default mode.

View Live Mode

Live images from the connected unit will display along with the current Date, Time and Alarm status of the

unit.

The following features are active in Live Mode:

The Pause button functions as Stop button.

The Pause, Disconnect, Multi-Camera, Camera Size, and Camera buttons are black and remain active.
The remaining buttons turn gray and are inactive.

The View Live command is replaced with the View Playback command.

The current Date and Time appears.

Multi-Camera live images can be viewed in 16-Way Large or Medium formats, or 4-way Large format.
Single Camera live images can be viewed in Large, Medium, or Small formats.

Clicking any camera image will display that camera image in full screen.

A red letter "A" opposite the camera number means an alarm for that camera.

View Playback Mode

To enter View Playback Mode, select Setup / View Playback from the menu bar.



Figure 30. The view playback command

[ 1] wavelet ‘Video Client’

File Setup~ Record Search Alarm-

IE address Baol

i Security

# Connection Type Setup »
——  View Playback
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L Image Quality Setup

4 Setup DVYMRe Menu
i

Live images for each camera stop updating.

The Disk Analysis Screen appears

All buttons return to black.

The View Playback command is replaced with the View Live command.
» WaveReader is still connected to the unit.

Return to Live Mode

When viewing live images is desired, the software may be switched back to the View Live mode via the Setup
menu.This option is added to the Setup Menu only after a Normal Connection has been established. Along
with the images being displayed, the current Date, Time and Alarm status of the unit are also shown.

To enter View Live Mode, select Setup / View Live from the menu bar.

Figure 31. The view live command
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File View | Setup Record Search Help
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Live Connections

When a Live Connection is made, the user is limited to viewing live images only. The user can establish a Live
Connection even if a different user has established a Normal Connection.To establish a Live Connection, select
Setup / Connection Type Setup / Live Connection from the menu bar.
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Figure 32. The live connection command
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No disk analysis screen is displayed.

Network Speed Setup

There are two Network Speeds that can be setup for connections between the WaveReader software and the
unit.

* Fast speed (LAN)
*  Slow speed (modem)

Figure 33. The network speed menu
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Fast (LAN) Connections

Most Local Area Networks and Wide Area Networks have a large bandwidth of (typically 10 Megabit or 100
Megabit). When the default Fast (LAN) option is chosen, the WaveReader software will download large
amounts of information from the unit such as the information required to display the Disk analysis window.
This normally takes only a few seconds when bandwidth is not restricted.

Slow (modem) Connections

When the Slow (modem) option is selected, it is normally because the bandwidth is limited. This causes delays
in getting information through the network. Unless the user’s Network Administrator has intentionally
restricted the amount of available bandwidth, this type of limitation may be due to network connections
established through modem connections or ISDN connections. In this situation it is not always advisable to
burden the network with so much data.

When the Slow (modem) option is chosen the WaveReader does not request the large amount of data needed to
display the Disk Analysis window. Playback starts at the beginning of the recorded data and proceeds to the
end.



In order to compensate for the missing Disk Analysis window, additional search capabilities have been
incorporated within the WaveReader software. These will be covered in Section 6.

Image Quality Setup

Once a connection has been established between the PC and a unit, the Image Quality Setup option becomes
available.
Clicking the right mouse button on this option causes the Image Quality Setup window to open.

This window allows the user to select the quality level for each type of display available in the WaveReader
software.

Figure 34. The image quality menu
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Quality levels are adjustable from Low to High. This setting instructs the unit on how much video content data
is required to display an image with the selected quality level.

Lower quality levels are more suitable for images displayed in smaller formats because the loss of fine detail in
the image is not as noticeable. Higher quality levels are required for images displayed in larger formats.

The user also has the option of having the image sent as a monochrome (B/W) picture.

The update rate in pictures per second is improved by lowering the quality level or by switching to
monochrome since both require less actual data to be transmitted. When both settings are combined, an even
greater update rate can be achieved.

This is especially useful when limited bandwidth is available or restrictions on bandwidth use are implemented
(as in a POTS connection).
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The Image Quality Setup Window

Figure 35. The image quality setup window
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Use the slider bars to adjust the quality settings for each of the display formats.
Place a check mark in the B/W box for each format if pictures should be sent as monochrome images.
Click the Apply button to temporarily apply the settings to the currently displayed screen.

When the settings are correct, click the OK button to save the changes or click the Cancel button to discard the
changes and return the settings to their previous levels.

Clicking on either the Cancel or OK buttons will clear this window and return the WaveReader software to
normal operations.

Setup DVMRe Menu

Configuring The DVMRe Menu System Remotely

WaveReader allows the user to access and make changes to the main menu system of a remote multiplexer. To
access the menu system remotely, the user must establish a Normal Connection via the ethernet. The menu
features cannot be accessed from a Live connection. For detailed information about configuring the menu
system, see the user manual for information specific to the multiplexer you are trying to configure.



Note:  The following menu items cannot be changed remotely if using a POTS connection.

e Factory Language

» Keyboard Lock

e Output Relays

e Full screen Alarm

» Baud Rates

e Auto Camera Disable
* Alarm Record Mode
» Record Lock

Setup DVMRe Menu
From the Menu bar, select Setup / Setup DVMRe Menu.

Figure 36. The setup DVMRe menu
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Select from the following options:

e Display DVMRe Menu
» Load Default Data

» Get from DVMRe

e Sendto DVMRe

» Load Data from a File
e Save Datato aFile

Display DVMRe Menu

» From the Menu bar, select Setup / Setup DVMRe Menu / Display DVMRe Menu.
e  Select the number of cameras for the multiplexer you are configuring.

35



WaveReader
User Manual

Load Default Data
»  From the Menu bar, select Setup / Setup DVMRe Menu / Load Default Data.
»  Select the number of cameras for the multiplexer you are configuring.

Get from DVMRe

Use this feature to download current menu settings from the selected unit, modify them, then return them
(Upload them) to the unit.

* From the Menu bar, select Setup / Setup DVMRe Menu / Get From DVMREe.

Send to DVMRe

This allows the user to configure the menu system of a remote unit by uploading a file containing the menu
settings.

e From the Menu bar, select Setup / Setup DVMRe Menu / Send to DVMRe.

Load Data From A File
Load multiplexer menu configuration data, so that it may be uploaded to the unit.
*  From the Menu bar, select Setup / Setup DVMRe Menu / Load Data From A File.

Save Data To A File

This allows the user to save the menu settings of the selected DVMRe, so that they may be used as backup, or
copied onto another unit.

*  From the Menu bar, select Setup / Setup DVMRe Menu / Save Data To A File.

The Record Menu

WaveReader allows the user to record directly to the hard disk via the ethernet connection.

Figure 37. The record menu commands
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To begin Recording:

1. Select Record / Record Setup from the Menu bar. A standard Save As menu called Filename for
Recording Image Sequence will appear.



2. Click on the Save as type drop down menu to select the file type. Choose between a .60d or .rdb (or
.20d if connected to a StoreSafe Pro 1) file type. Type the desired file name in the File Name box.
Click the Save button.

3. Select Record / Start Recording from the Menu bar to begin recording the images displayed in the
Main window.

4. Select Record / Stop Recording from the Menu bar to stop recording.

Note:  Only images actually being displayed will be recorded. Recordings will be made using the quality levels set for the
images displayed.

Playing Back From a .20d, .60d or .rdb File
To playback the recorded data described in the previous section:

» Disconnect from the unit if currently connected.

» Select File / Open from the Menu bar. A window called Open Wavelet Data Files will appear.
» Selecta.20d, .60d or .rdb from the Files of Type box.

»  Select file location from Look in box or type file name in File Name box.

» Click on the Open button.

» Playback file by clicking the Play button.

The Search Menu

Once a Normal Connection has been established between the PC and a unit, the Search Menu option will
appear in the Menu Bar and the Search Icon will become available in the Icon Bar. Searches are only possible
on files or when connected to DVMRe and StoreSafe units with software version 5.02 or later.

Launch the Search screen by clicking on the Search icon Q or the Search menu option. The Search Screen
has two modes basic and advanced. The Search screen is in basic mode when it first appears as shown below.

Figure 38. The search filters menu in basic mode

Search Filters =0 x|
File Setup

I Date

[T Cameras

[~ Hours of the Week  Setup | Search Advanced >>

Note:  If no alarm, event or text filters are selected and a search is launched the search results will only display the start and
stop boundries of the recorded video.
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Basic Mode

In basic mode, the user can set up the Date, Cameras, and Hours of the Week filters. The Hours of the Week
filter is only available if searching on files or if connected to DVMRe Triplex units with software version 5.02
or higher. Selecting any of these parameters modifies the Search Filters screen and displays that selection’s
options. The screen below shows the Search Screen with all three Filters selected.

Figure 39. The basic search filters window with filters selected
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The Search Filters Menu bar contains the File and Setup menus.

The File menu contains the Load Search Filters menu and the Save Search Filters menu. Search filter
combinations may be saved and loaded through these menus for use on different devices. Filter parameters in
the saved file that are not applicable on a particular device are ignored during the Search. Search filter
parameters are saved in xml format in the QuickWave directory.

The Setup menu contains the Mode menu and the Search Schedule menu. See Scheduled Search on page 41
for a detailed explanation of this feature.

The Mode menu is used to select the way the search is reported, Batch or the default Interactive. The batch
mode does not have any result quantity limitation and all results are written to a file. The file format choices
are txt, html, or xml.

The Go To button in the Date filer section begins transmitting recorded video from the closest point to the time
and date selected.

The Hours of the Week filters option is used to apply another level of date/time filtering when doing the
search. For example, the user can specify that he only wants to search on Mon, Wed and Fri between 8am-5pm.
Clicking on the Setup button will display the Hours of the Week selection window as shown below.



Figure 40. The hours of the week window
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To use this window click Enable in the Edit Mode box make your selections and click on Done.

The Search button will execute the search based upon the filter selections and launch the Search Results
window as long as the Search Setup mode is Interactive. See Search Results on page 42 section for more

details.

Clicking on the Advanced button will expand the Search Filters screen to include filters such as Alarm/Event,

Text, and Motion. The screen shown below is shown with the Text tab selected.

Figure 41. The search filters in advanced mode
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Advanced Mode

In the advanced mode, the user can specify alarm/event, text, motion filters in addition to camera, date and
week. If the user is not logged in or doesn’t have rights to do an advanced search, the user cannot switch to
advanced mode. The advanced button will be grayed out.

The Alarm/Event tab executes searches based upon Alarm or Event flags.

The Text tab has basic and advanced modes of operation. The basic mode allows the user to type in text and
search for it. The advanced mode allows users to search on strings or conditions. Advanced text mode searches
are only available if searching on files or if connected to DVMRe Triplex units with software version 5.02 or
later.

In addition to the search strings, up to 5 search conditions can be defined. Search Conditions allow the operator
to do Greater than/Less than/Equal to type of searches based on numeric values that are contained in text
strings. For example a search condition could be set up to find all lines where the string Total is found with a
value greater than $100.

Every condition filter has 4 entries:

» Text - text to search for — Can be typed manually or can be entered automatically by selecting words
from the Search list and then dragging it with the mouse and dropping it into the Text box.

e« Condition->=,<=, =
* Value — Numerical value
* Additional Text — other text that must appear in the line along with the String and Numerical value

» Atextcondition “*” can be used as a wildcard that matches all strings and basically just evaluates the
numeric portion of a line of text.

Any combination of the 25 Search list strings and the 5 Conditional filters can be used together when doing a
search.

The Motion tab bases searches by camera and screen area. The screenshot below shows only the motion tab
area of the advanced search screen. Enabled grid sections are displayed in yellow, disabled sections in red.

Figure 42. Motion search window
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Scheduled Search

The Schedule(d) Search menu allows the user to run a search on a single unit or a multi-site group at a
specified time and on certain days and save the results to a file. The scheduled search runs in the background.

This icon ‘gt displays on the main WaveReader screen and indicates that a scheduled search is running. To
stop the scheduled search double-click this icon. The user must be logged in for the scheduled search to run. If
the logged-in user does not have the rights to see the sites specified in the schedule the search will be
abandoned.

The user must setup the scheduler in order to run a scheduled search. To do this select Setup/Schedule from
the Search screen. The following setup screen displays.

Figure 43. The search schedule screen
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Select the Time.
Select the Recurrence Pattern.

Select the Range of Recurrence.

> w0 e

Select the Search Filters File. This is a file containing the parameters required to do the search. This
file must have been previously saved using the File/Save Search Filters menu on the Search
Filters screen. Motion search is the only kind of search that is currently not supported when
scheduling a search.
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5. Name the Search Output File. This is the file that will contain the results of the search. This can be
saved as a html or xml file. The filename specified by the user cannot have an underscore in it. When
the scheduler runs, it checks if a file with the output filename specified already exists. If it does exist,
the scheduler creates a new output file using the user specified file name suffixed with an _x, where x
runs from 1 to 365 (eg. searchout_1.xml, searchout_2.xml.... etc). When the max count (365) is
reached, the file will start getting overwritten.

Note:  Note: We recommend that the user save the search filter files and output files in separate folders.

6. Select the Site/IP List. The Site/IP List specifies the unit/group against which the scheduled search
will run. Select this using the Address Book button.

7. Click on the Save button to save all the parameters. These parameters will be saved in a file called
SearchSchedule. XML in the WaveReader/Scheduler folder. When a user logs in, the scheduler will
use this file to schedule the search. The scheduler will not run if the start date specified is more than
two weeks from the current date.

8. Click on the X (close window icon) in the upper right hand corner of the window to exit.

Search Results

The results of any search are displayed in the Search Results window. The search is automatically cancelled
after the first 1000 lines of results are received. If more results are available, the Next button will be enabled
and the user can use this to see the next set of 1000 results (for an advanced text search) or 10 results (for a
basic text, alarm/event, motion search).

Figure 44. The search results screen
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000000 S9/8/2003 11:26:59 AM 1 Test [AGNT] aluantve Inc.  $80.61
000001 [CSAV] CoolSavings, Inc,  $45.78
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000003 [ECGI] Envoy Communications $6.46
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000003 [ORTC] Ortec Intemational Inc.  $39.34
000010
000011 9/8/2003 11:27:01 AM 1 Text [RCI] Renal Care Group, Inc.  $88.97
000 2 [SRZ] Sunrise Assisted Living, Inc.  $34.71 LI
< | 2]

GROUP BY [..SHOw ALL--[86] =]

New | Dore_|

When doing an advanced text search, the search results window will show lines that had a string match in red
and lines that had a condition match in blue.

The search results window will also allow results to be displayed based on search filter. A bracketed number
next to the search filter name will indicate the total number of lines that matched the respective search filter.
The number next to SHOW ALL indicates the total number of transactions that matched one of the search
filters.

The search can be cancelled at any time by clicking the Cancel button on the progress bar. If a search is active,
user cannot start a new search.
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The search results can be saved to a file by using the Save or Save Selected options under the File menu. The
user can choose the file type (txt, xml or html) and specify the directory where the file should be saved.

Search results can also be printed using the Print option under the File menu.

WaveReader cannot play when doing a search. Clicking on an item in the search results window will cause the
respective image to be displayed in the WaveReader window.

Multi-Site Mode

The Multi-Site Mode menu options can be accessed through the main menu bar. To access the Multi-Site Mode
commands, select Multi-Site from the menu bar. Multi-Site mode is a new feature of WaveReader that allows
the operator to view cameras from multiple Triplex units simultaneously on custom definable screens.

Note:  Multi-site mode is only available on the DVMRe and DVMRe Triplex units. Also DVMRe and DVMRe Triplex units must not
have their Unit Types modified from their deafualt types in the Unit Type Setup menu.

Multi-Site mode supports simultaneous connections to up to 16 Triplex units. This gives the user access to up
to 256 different cameras. These cameras can be arranged and displayed in any combination on custom
definable screens up to a maximum 64 cameras at a time. The user can define up to 25 different Custom
Screens that can consist of any mixture of 4, 16, 36 and 64 way screens.

Every Custom Screen can be given a unique name that describes the units whose cameras are grouped within it.
These screens are ideally suited to group cameras from Triplex units that are located in the same geographic
area. For example, if a school has two Triplex units in their security layout, all 32 cameras can be displayed
simultaneously in one 36 way Custom Screen.

Start Multi-Site Mode

To enter Multi-Site mode, simply click on the Start menu item. The two modes that can be chosen from are
Live and Play.

Figure 45. Multi-site menu

El Wavelet Reader

» Live: In Live mode, all connections that are made to Triplex units will be live-only connections. This
is the preferred way of connecting when many users are connecting to the same triplex units and
everyone wants to view live images.

» Play: In Play mode, all connections that are made to Triplex units will be Normal connections. This
mode allows the operator to review recorded data from several Triplex units simultaneously by doing a
search to a specific time and date.
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After Live or Play mode is selected, WaveReader will enter into Multi-Site Mode.

Figure 46. WaveReader in multi-site mode
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Stop Multi-Site Mode

To return to normal WaveReader mode, simply click on the Stop menu item in the Multi-Site menu.

Create a Site Group

A Site group is any combination of sites (up to 16), chosen from the user’s address book, from which cameras
can be chosen to create Custom screens. The user can create any number of Site Groups and the same site may
belong to any number of these Groups.

To add a new Site Group, delete a group or to change the name of an existing group, select the Add/Delete Site
Group menu.
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Figure 47. The site group window
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To add new sites to a Site Group, change the sites that belong to a Site group or simply view the sites in a Site
group, select the Site Group Setup menu. At the top of the setup screen, all sites in the address book are listed.
At the bottom of the screen the sites that have been added to the Site list are displayed. To add a site to the list,
select the site in the top window and click the Add button. To remove a site from the list, select the site in the
bottom window and click the Remove button.

Figure 48. The administrators site group window

@ndministrator's Site Group (1) B _)ﬂ

Available Sites
Site Description IP/Phone No. Unit Type  |Camera QTY! City State/Province

*

Add | Remove ] Add _[.1er.:—u|f:_-| Clear I

Selected Sites

Site Descripti
GB's unit

IAdminis!ralor's Site Group (1] ﬂ Cancel | Refresh I Close I

Sites can easily be set up for all existing Site groups by simply selecting the Site Group name from the Drop-
down box in the bottom left corner of the Site Group setup screen. The name of the selected Site Group will
appear in the title of the screen.

The site lists will be saved when the Close button is clicked or when the user switches to a new Site Group.
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How to add a new (or edit an existing) Custom Screen

To create or edit a Custom screen, select the Screen Setup menu. While in this setup mode, connections to all
the sites in the group will be established and snapshots of all the available cameras will be downloaded. The
Site group for which the custom screens are defined can be selected in the drop-down box on the left top of the
screen.

A new screen can be added by clicking the Add/Delete Screen button. The screen must be given a unique
name and must be either a 4, 16, 36 or 64 way.

Figure 49. Multiscreen setup screen
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Once a new custom screen has been added, it can be selected by clicking in one of the 4 icons on the left of the
setup screen. If you want to edit a new 36-way screen, click on the 36-way icon and select the screen name
from the drop-down list. A 36-way grid will appear that can be modified as described below.

On the left top of the setup screen a list of all the sites will be displayed. By clicking on a specific Site in the
list, snapshots from all of its cameras will be displayed at the top of the screen.



The area containing the grid is where the screen layout is designed. The operator can place any camera from
any unit, anywhere on the grid. Cameras can be added to the grid in any of the following 3 ways:

e Click on an image at the top of the setup screen and drag it (while keeping the left mouse button down)
to the desired block in the grid and then drop it by releasing the mouse button.

» Click on the + symbol next to the site in the preferred list to expand it into a list of Camera titles. Click
and drag the Camera Title to the desired grid position.

»  Click on the site name in the preferred list, hold the mouse down and drag it to a cell in the grid. While
dragging, the mouse cursor will turn into a Hand holding a Page picture. When the mouse button is
released, all available cameras for that site will be added to the grid (starting at the cell where the

mouse was released and filling up the cells in the row towards the right) wrapping around to the next
row if needed.

Right clicking the mouse and selecting Delete can clear cells in the grid. Clicking the clear button to the left of
the grid will clear the whole screen.

Images already dropped on the grid can be moved around by clicking and dragging them around on the grid.
By holding in the Control key before clicking and dragging, a copy of an image can be created and moved to a

new cell in the grid.
How to change to a new Custom Screen

To change to a new Custom screen, choose the screen name from the Select Screen menu. Another way of
selecting a screen is to select it from the Screens button on the right hand side of the toolbar.

Figure 50. Changing custom screens
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In both cases, the screen list consists of some Default screens followed by the user’s custom defined screens.

» Default 16 Way Screens: The screens at the top of the list are all 16 Way screens and are
automatically created — one for every Site in the site list. It shows all 16 cameras connected to a
Triplex. This is equivalent to the old WaveReader 16 way screen.

e Custom Screens: The screens at the bottom of the list are the screens that are created by the operator.
They can be 4, 16, 36 or 64 way screens. These screens can contain cameras from 1 to 16 Triplex units.

Multi-Site Search

WaveReader supports searches across multiple or Multi-Site units. To execute a Multi-Site Search:
1. Select Multi-Site/Start/Play from the Main Menu.

2. Select the Multi-Site on which the search is to be performed from the Screens drop-down menu.

Click the search icon .a .

The Search Screen will appear, select the search parameters as you would for a single unit and click the
Search button. WaveReader will send a search request with the selected parameters to all the units in the
current group and display the results in a new screen.

Figure 51. Multi-site search results screen

|li]search Results _ o =10} x|
Administrator’s Site Group (1) [ ¢ | Stat Time | End Time | Camera | Type | Tew I
000000  2/12/2004 6:52:48 PM 2/13/2004 8:03:08 AM 234558 Event
000001 2/13/2004 8:10:52 AM 21772004 3:41:17 AM 234556 Event
000002 2/17/2004 3:41:19 AM 2/17/2004 3:41:58 AM 238 Event
000003  2/17/2004 3:42:00 AM 21772004 34210 AM 28 Event
000004 2A17/2004 3:42:12 AM 2/17/2004 9.46:46 AM 23568 Event
000005 2/17/2004 3:46:48 AM 2/27/2004 9:20:07 AM 234556 Event
%l NO OF RESULTS: 6 Newhil | StopAl | Dore |
s

The Search Results screen will list the IP addresses of all the units in the current group in a tree view on the
left portion of the screen. The search progress will be indicated as a percentage value in brackets next to the IP
address. When the search has completed, the percentage will indicate 100 and the color of the IP address text
will turn green. By default the search will pause after receiving about 100 results (or 30,000 bytes) and the
color of the IP address text will turn red. The Next All button can be used to continue the search on all units
that are paused. The Stop All button can be used at any time to stop the search. To see the search results from a
particular unit, click it's IP address. The corresponding results will be displayed in a list view on the right and
the result count NO OF RESULTS will be displayed at the bottom.

Click on a record to view that particular video.



The Alarm Monitoring Menu

The Alarm Monitoring menu options can be accessed through the main menu bar. To access the Alarm
Monitoring commands, select Alarm-Monitoring from the menu bar.

Note:  Alarm monitoring is not available on any StoreSafe model.
The following commands are available:

«  Start the Alarm Monitor
»  Stop the Alarm Monitor

Start the Alarm Monitor

This command launches the Alarm Monitor Screen.

Figure 52. The alarm monitoring screen
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The Alarm Monitor screen lists all the conditions that have been reported to WaveReader. The screen consists
of two tables.

The topmost table displays data in a list format. Every row in the table represents a specific camera on a
specific Triplex from which alarm images have been uploaded. Sometimes it can happen that a Triplex reports
alarms on more than one camera. In this case more than one row will be added to the table.
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Every row in the table consists of the following fields:

» Date/Time — Specifies exactly when the alarm happened in the calling unit’s time.
» Site Description — IP address of the unit that reported the alarm
» Site Serial Number — the Serial number of the unit that called
» Camera - The camera number associated with the alarm
e Type - The type of alarm
*  Pre— Number of Pre-Alarm images that were uploaded
e Main - Number of Main-Alarm images that were uploaded
» Post - Number of Post-Alarm images that were uploaded
e Format - Video Format (NTSC or PAL)
Right-click on a row to launch a notes window that can be used to enter pertinent information about that

specific alarm. Multiple users may add different messages to the same alarm. Each time a message is added the
username and the time and date will be logged and appended to the notes field.

Figure 53. The alarm notes pop-up window
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The function of the Connect button is to allow the user to connect back to the unit that generated the alarm.
The play pointer on the unit's hard disk will be automatically placed at the position where the alarm occurred.
This allows the user to do more detailed investigation by looking at what was recorded before the alarm
happened.

Images from a specific camera or cameras can be played back by selecting the corresponding row or rows
using the mouse and then pressing the Play button. When only a Pre, Main or Post section is selected, only
those images will be played back. The Single step buttons may also be used while analyzing the data.
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Status Information about the Triplex unit that called can be viewed by clicking on the Site Info button.

When data from a camera has been reviewed, it can be deleted from the database by pressing the delete key on
the keyboard or it can simply be marked as reviewed by clicking the Unmark as New button menu.

New alarms will be shown in red and those that have been Unmarked will be displayed in white. The user can
either view all the rows in the database by clicking the All button or he can only show the new alarms by
clicking on the New button.

The Setup menu on the Alarm Monitor Screen allows the user to specify the maximum number of images to
upload for the Pre, Main and Post alarms.

Figure 54. Alarm monitor settings
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The table on the bottom of the Alarm Monitor screen logs all reported items that do not have associated
images. The items that will be logged include:

* Video Loss — Any change in the video loss status
» Recording — Starting and Stopping Recording
» Archive device — State changes (e.qg. tape full)
*  Menu access — Entered menus — exited menus
* Power up - The Triplex reports its power-up time

* Unit Connections — The IP Address of every PC that connects to or disconnects from the Triplex is
reported.

The System Log shows the IP address of the calling unit, the timestamp when it was reported and a description
of the item.

The information in the bottom table can be copied to the Windows Clipboard by using the Copy System Log
menu or it can be deleted by right clicking on the table.

Stop the Alarm Monitor

This command halts Alarm Monitoring.
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The Help Menu

The Help menu options can be accessed through the main menu bar. To access the Help command, select Help
from the menu bar.

Figure 55. The help menu
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This menu allows the user to:

»  Access Help Topics.
*  Obtain Mux Information.
» Obtain Software version and System Info.

Help Topics

The Help Topics are available in this menu and for context sensitive help on some options, depress the F1 key
while the mouse is hovering over a feature.

About Mux

The About Mux command provides information about the connected Mux.

Figure 56. The about mux window

~inid
Model Mumber: |StoreSate Pro i
Serial Number: IDBUU-YF'1 28116593

MAL Address: [o0E015E 20540
Software Yersior: IB.DD
Digk Size: |suu GE

The following information is viewable:

e Model Number.

e Serial Number.

« MAC Address.

e Software Version.
» Disk Size.
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The About command provides information about the Version number of the Software.

Figure 57. The about window

@Ahout WaveReader

|m waveReader

Wersion 4.2.14

‘Wavelet Reader is used for the retrieval and viewing of
digital images recorded by the DVMRBe / DSR / DVS

range of digital Multiplexer /%CR / Video Storage
products.

Sypstem Info |

Access to the Windows System Info command is also available in this window. Extensive System information
can be retrieved with this command.
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Using WaveStudio

WaveStudio is an image enhancement program designed specifically for use with WaveReader. WaveStudio
allows the user to capture and save images. WaveStudio also allows the user to increase or decrease contrast,
zoom, sharpen lines, enhance sections of the picture, and bring out detail in dark areas.

Opening WaveStudio

From the Menu bar, select File / Start Wavestudio or click on the WaveStudio icon on the Icon Bar. The
WaveStudio window will open. The WaveStudio window consists of two areas, the Main Viewing Area and
the Toolbar.

WaveStudio Toolbar

All of the functions in WaveStudio are performed using the toolbar located on the left side of the WaveStudio
window.

Figure 58. The WaveStudio toolbar
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Intensity: Changes the overall brightness (intensity) of the image.
Contrast: Increases or decreases the contrast of the image.

H. Contrast: Increases or decreases the contrast of the image in a image, using a histogram to determine the
median brightness.

This method finds the median brightness of the image; then brightens the pixels with values above the median
and darkens the pixels with values below the median. This is more sophisticated (but slower) than the regular
contrast method, which uses the middle possible value (128) rather than finding the actual median.

Hue: Changes the hue of colors in the image by rotating the color wheel. The user can rotate the color wheel
in either direction. A 180-degree rotation in either direction changes each color to its complement. Positive
rotation takes red toward green, green toward blue, and blue toward red. Negative rotation has the opposite
effect.

Saturation: Negative values decrease the saturation of colors. Positive values increase the saturation. The
saturation level is increased or decreased by a percentage of its present saturation level.

Sharpen: Increases or decreases the sharpness of the image. Negative values decrease the sharpness of the
image. Specify —1000 for minimum sharpness. Positive values increase the sharpness. Specify +1000 for
maximum sharpness.

Zoom: Clicking the In or Out button will cause the image to begin increasing or decreasing in size. Click the
Stop button to stop the zooming. Click the Normal button to return the image to the original size.

Noise Removal: Changes the color of each pixel in the image to the average color of the pixels surrounding it.
This results in a blur effect.

Histogram Equalization: Linearizes the number of pixels per gray area in the bit map. This can be used to
bring out detail in the dark areas of an image.

Region Selection: Used to isolate sections of an image for enhancement. Select Rectangular to drag a box
over the desired picture area. Select Freehand to draw borders around the desired area. Click On to activate
this feature.

Copy & Paste: Use these buttons to copy images to or from the clipboard.
Undo: Click this button to undo all changes made to the image.

Done: Click on this button to close the WaveStudio program.

WaveStudio Main Viewing Area.

When WaveStudio is opened, it automatically captures the image currently displayed in the WaveReader Main
Viewing Area.
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Figure 59. WaveStudio main viewing area

Use the WaveReader window to find and pause the exact image you wish to edit.

Press the Load button to insert the image into the Wavestudio’s Main Viewing Area.

Any image size or screen configuration displayed in the WaveReader Main Viewing Area can be copied to the

WaveStudio Main Viewing Area.

Opening a File in WaveStudio

To open a file in WaveStudio, select File / Open from the Menu bar. The open file requestor window will
appear. Navigate to the file to edit, select the file and click the open button.

Figure 60. The open a file requestor box
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Dome Pan/Tilt/2Zoom Control

Entering PTZ Mode

WaveReader provides Pan/Tilt/Zoom capabilities. To access the PTZ controls from WaveReader, the following
conditions must be met:

» WaveReader must be connected (via the ethernet or POTS) to a DVMRe capable of interpreting the
PTZ commands.
» The DVMRe unit must be connected to a ProBridge PTZ controller. The DVMRe Triplex does not
require a ProBridge PTZ controller.
» The cameras must be capable of performing PTZ.
» The WaveReader must establish a Normal connection, and must be in Live Look-in Mode.
Note: Modem connection for PTZ commands is not recommended. Due to bandwidth and typical phone line limitations of

modem connections, PTZ functions may be very sluggish. If PTZ control via modem is required, we recommend that the
Go To Preset command be used, rather than manual PTZ operation.

Panning And Tilting

To pan or tilt a camera:
Select the desired camera from the multiscreen by clicking on it.

Click and hold the cursor on the image. The square (shown here) will appear.

Figure 61. Mousetrak control box

Drag the mouse in the direction you wish to pan or tilt. A number from 1 to 10 will appear in the square,
indicating the rate of pan or tilt (10 being the fastest).

Nudge

To nudge the camera position a single predefined increment, left click the mouse close to the image borders.
Clicking on the left edge will nudge the camera to the left, etc.
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Auto-Center

Double clicking on the image will cause the camera to re-center the image at that location. Current zoom
position is maintained.

Camera Controls

Once the above conditions have been met, the additional menu items (shown here) are added to the Main
Window of the WaveReader.

Figure 62. Camera controls

Set GoToN

Preset 1 l]

1. Focus In & Out
Click and hold the Focus In & Out buttons to operate lens focus.

Shortcut: Holding down the Alt key and dragging the cursor up/down on-screen (as if you were tilting the
camera) will operate the focus

2. Iris Open & Closed

Click and hold the Iris Open & Closed buttons to lighten or darken the image, and adjust for changing light
conditions.

Shortcut: Holding down the Shift key and dragging the cursor up/down on screen (as if you were tilting the
camera) will operate the iris control.

3.Zoom In & Out
Click and hold the Zoom In & Out buttons to operate the camera lens zoom.

Shortcut: Holding down the Control key and dragging the cursor up/down on screen (as if you were tilting the
camera) will operate the zoom control.

4. Auto Zoom In

Click the Auto Zoom In button, then click and draw a rectangular window on the currently displayed image
with the left mouse button. Once the button is released, the camera will automatically zooms to the drawn



window. If the window size is beyond the camera’s zoom capabilities, the image will center on the middle of
the defined window at the maximum zoom-in position.

5. Return - Previous

Click on this button to return the camera to the PTZ position that was selected prior to the last Auto Zoom In
command

6. Zoom All

Click on this button to zoom all the way out on the currently selected camera.

7. Set Preset

Navigate the camera to the desired location, select the desired preset from the drop down list box, then click
Set.

8.GoTo

To send the camera to the desired preset, select the preset from the drop down list box, then click Go To.

9. Preset drop-down list

Select from previously created presets.
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QuickWave Evidence Capture CD

WaveReader allows any PC user with a CD writer to create a portable evidence CD, which includes an auto-
launching lite version of WaveReader called QuickWave. WaveReader does not need to be installed on the PC
for QuickWave to operate, and QuickWave does not install itself (or a version of WaveReader) on the PC upon
which it is being played-back. The program is loaded and played directly from the QuickWave CD.

The QuickWave CD cannot be played back on Windows 95 or Windows 98 Release Version 1.

Note:

Live audio will not be recorded while archiving is in process.

Creating The QuickWave CD

1.

Use the Disk Analysis Screen in WaveReader to select and save the desired video data as a .20d or .60d
file.

Copy the .20d or .60d file (or files) to the C:\Program Files\WaveReader\QuickWaveCD\QuickWave
folder.

Using the CD writer software, select the contents of the C:\Program
Files\WaveReader\QuickWaveCD folder.

Note: Do not select the QuickWave CD folder to be written by the CD writer. Select the contents of the
QuickWaveCD folder to be written by the CD writer.

Using the CD writer, create the QuickWave CD.

Test the CD by placing it in the CD drive of your computer. The QuickWave program should launch
automatically, and begin playing the .20d file first, then a .60d file if one exists on the CD.

Note:  When finished creating the QuickWave CD, delete the .20d or .60d file (or files) from the C:\Program
Files\WaveReader\QuickWaveCD\QuickWave folder, so that it does not accidentally get copied onto a
QuickWave CD (for which it was not intended) in the future.

Playing The QuickWave CD

Place the QuickWave CD in the CD drive of a PC.

The QuickWave program will launch from the CD and begin playing the .20d file first, then a.60d file
if one exists on the CD.

QuickWave’s operation is similar to that of WaveReader except for the fast forward and rewind
buttons. These commands are not functional on these file types.

Select File / Open to playback a different .20d, or .60d file.

Creating a QuickWave CD using the CD Wizard

When WaveReader is running on a PC that has DirectCD® Version 3.0 or later installed, the Wizard can be used
to automate the process of creating a QuickWave CD.



Select File / Start QuickWave CD Wizard from the menu to launch the Wizard. (If this menu item
does not appear in the menus, then the DirectCD® could not be detected on the PC and the Wizard
cannot be used.

The Wizard will guide you through the CD creation process.
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SplitWave

SplitWave is a stand-alone program that is designed to split large .60d files into smaller files. The SplitWave
installation program is located on the WaveReader CD in the SplitWave directory.

Installing SplitWave

Insert the WaveReader CD in the computer’s CD-ROM drive. Cancel the WaveReader installation procedure if
it is already installed.

Use Windows Explorer to navigate to the SplitWave Folder.

Double-click on the Setup.exe file.

SplitWave Operation

Launch SplitWave by double-clicking on the SplitWave Desktop icon or choose Programs from the Start
menu and then select SplitWave.

Figure 63. THe SplitWave window
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1. Click on the Source File radio button to navigate to the .60d file that you want to trim.




Click on the Target File radio button to navigate to the location of the new file.

Click in the Set Custom Time Range box to expand the screen to include Start and End Time
selection parameters.

Use the Sliders to select the size of the new file.
Click on the Check Availability box to check the available cameras.

Click these buttons to Save File, or Exit the operation.
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Contacting technical support

For assistance installing, operating, maintaining, and troubleshooting this product, refer to this document and
any other documentation provided. If you still have questions, you may contact technical support and sales
during normal business hours (Monday through Friday, excluding holidays, between 6 a.m. and 5 p.m. Pacific
Time).

Table 2. Sales and support contact information

Sales Technical support

Phone: 800-469-1676 888-437-3287
E-mail cvovideosales@ge.com generaltech@ge.com
Fax 541-754-7162 541-752-9096 (available 24 hours a day)

Note:  Be ready at the equipment before calling for technical support.

Online publication library

Another great resource for assistance with your GE Security products is our online publication library,
available to all of our customers on our website. To access our publication library, go to our website at the
following location:

http://www._gesecurity.com

In the Tools area at the top, click the Publication Library link then select Video Surveillance. After you
register and log on, you may search through our online library for the documentation you need.:

1. Many GE Security documents are provided as PDFs (portable document format). To read these documents, you will need
Adobe Acrobat Reader, which can be downloaded free from Adobe’s website at www . adobe . com.


mailto:cvovideosales@ge.com?Subject=Sales --
mailto:generaltech@ge.com?Subject=Tech Support --
http://www.gesecurity.com
http://www.geindustrial.com/ge-interlogix/tools/index.html
http://www.geindustrial.com/ge-interlogix/survey/login.jsp?to=http://www.ge-consultantlink.com/search_portal.asp&c=21
www.adobe.com

	User Manual
	Introduction
	Conventions used in this document
	Safety terms and symbols

	Product Overview
	Product Description
	Features
	Minimum System Requirements
	Table 1. Minimum system requirements


	Getting Started
	Installation
	Installing From CD-ROM

	Starting WaveReader
	Figure 1. Initial WaveReader screen
	Logging In
	Figure 2. Login Screen
	Figure 3. The Address Book

	Connecting to a Site/Device via the Address Book
	Figure 4. WaveReader Screen after a successful login



	WaveReader Reference
	WaveReader Main Window Overview
	Figure 5. Main window overview

	The Main Program Window
	The Menu Bar
	Figure 6. The menu bar

	The Icon Bar
	Figure 7. The Icon Bar

	The Main Viewing Area
	The Status Bar
	The Button Panel
	Figure 8. The button panel

	Activated Button Indicator
	The Text Data Display Box
	The Image Control Pop-up Menu
	Figure 9. The image control pop-up menu


	Changing Languages

	WaveReader Operation
	The File Menu
	Open File
	Figure 10. The open file dialog box
	Figure 11. WaveReader playing a file

	Save Image
	Print Image
	Start WaveStudio
	Log In/Off
	Exit

	The View Menu
	The Disk Analysis Screen
	Figure 12. The disk analysis screen
	Figure 13. Disk analysis pop-up

	The Volume drop down list box
	Figure 14. The volume drop-down list

	Saving A File From The Disk Analysis Window
	The Text Log
	Figure 15. The text log


	The Setup Menu
	Figure 16. The setup menu
	The Address Book
	Figure 17. The address book
	Figure 18. Editing the address book


	The Security Menus
	Security Shell Overview
	Using the Security database from multiple computers.
	Additional Notes

	Security Menu Sub Menus
	Figure 19. The security sub-menus
	Change Password
	Figure 20. The change password window

	View User Rights
	Figure 21. The groups rights window

	Site Administration
	Figure 22. The sites administration window
	Figure 23. Importing an address book
	Figure 24. The address file

	Group Administration
	Figure 25. The groups window

	User Administration
	Figure 26. The user window

	Unit Type Setup
	Figure 27. The unit type window

	Custom Caption Setup
	Figure 28. The custom caption setup window


	Connection Type Setup
	Figure 29. The connection type setup sub-menus
	Normal Connections
	View Live Mode
	View Playback Mode
	Figure 30. The view playback command

	Return to Live Mode
	Figure 31. The view live command

	Live Connections
	Figure 32. The live connection command


	Network Speed Setup
	Figure 33. The network speed menu
	Fast (LAN) Connections
	Slow (modem) Connections

	Image Quality Setup
	Figure 34. The image quality menu
	The Image Quality Setup Window
	Figure 35. The image quality setup window


	Setup DVMRe Menu
	Configuring The DVMRe Menu System Remotely
	Setup DVMRe Menu
	Figure 36. The setup DVMRe menu

	Display DVMRe Menu
	Load Default Data
	Get from DVMRe
	Send to DVMRe
	Load Data From A File
	Save Data To A File

	The Record Menu
	Figure 37. The record menu commands
	Playing Back From a .20d, .60d or .rdb File

	The Search Menu
	Figure 38. The search filters menu in basic mode
	Basic Mode
	Figure 39. The basic search filters window with filters selected
	Figure 40. The hours of the week window
	Figure 41. The search filters in advanced mode

	Advanced Mode
	Figure 42. Motion search window

	Scheduled Search
	Figure 43. The search schedule screen

	Search Results
	Figure 44. The search results screen


	Multi-Site Mode
	Start Multi-Site Mode
	Figure 45. Multi-site menu
	Figure 46. WaveReader in multi-site mode

	Stop Multi-Site Mode
	Create a Site Group
	Figure 47. The site group window
	Figure 48. The administrators site group window

	How to add a new (or edit an existing) Custom Screen
	Figure 49. Multiscreen setup screen

	How to change to a new Custom Screen
	Figure 50. Changing custom screens

	Multi-Site Search
	Figure 51. Multi-site search results screen


	The Alarm Monitoring Menu
	Start the Alarm Monitor
	Figure 52. The alarm monitoring screen
	Figure 53. The alarm notes pop-up window
	Figure 54. Alarm monitor settings

	Stop the Alarm Monitor

	The Help Menu
	Figure 55. The help menu
	Help Topics
	About Mux
	Figure 56. The about mux window

	About
	Figure 57. The about window



	Using WaveStudio
	Opening WaveStudio
	WaveStudio Toolbar
	Figure 58. The WaveStudio toolbar

	WaveStudio Main Viewing Area.
	Figure 59. WaveStudio main viewing area

	Opening a File in WaveStudio
	Figure 60. The open a file requestor box


	Dome Pan/Tilt/Zoom Control
	Entering PTZ Mode
	Panning And Tilting
	Figure 61. Mousetrak control box

	Nudge
	Auto-Center
	Camera Controls
	Figure 62. Camera controls
	1. Focus In & Out
	2. Iris Open & Closed
	3. Zoom In & Out
	4. Auto Zoom In
	5. Return - Previous
	6. Zoom All
	7. Set Preset
	8. Go To
	9. Preset drop-down list


	QuickWave Evidence Capture CD
	Creating The QuickWave CD
	Playing The QuickWave CD
	Creating a QuickWave CD using the CD Wizard

	SplitWave
	Installing SplitWave
	SplitWave Operation
	Figure 63. THe SplitWave window


	Contacting technical support
	Table 2. Sales and support contact information
	Online publication library



